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Can any hand held scanner
display data like this?
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(We didn’t think so)

EASE CAN!

Start scanning with EASE today!



EASE PC SCAN TOOL

; . Turn your PC into a powerful diagnostic workstation!
H——j == ﬁﬁruwpra Get high-speed access to vehicle data on your PC so you can easily and quickly
e S - perform diagnostics with the EASE PC Scan Tool. This powerful system offers more
features than any other scan tool - hand held or PC based. Other scan tools only
show you a few lines of vehicle parameter values, with no way to put the whole
picture together. With the EASE PC Scan Tool, you'll see loads of vehicle data in a
user friendly format on your large PC screen so you can quickly see the whole picture
- making your job much easier.
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"The EASE
Scanner is, in
our opinion,
simply the
hest tool of
its kind in the
world.”

MOTOR
Magazine

Can Any Hand Held
Scanner Display
Data Like This?

EASE CAN!

- FEATURES -

The EASE PC Scan Tool was designed for automotive professionals and provides all the features you need to quickly identify
vehicle problems.

v/ Cabled or Wireless Scanning v' Advanced database filtering to help you quickly find a
v User-friendly software with easy navigation previous vehicle or recording
v' On-line help v/ Print Screens
v" Vehicle selection database v Professionally printed reports
v View data parameters in grid, graph or meter format v’ Include any screen shot or photo in a PC Scan Tool
v’ 6 graphing windows w/graphing auto scale, zoom and pan Report with our Screen Grabber feature
v Meter configurations with Min/Max determination v/ Multiple user feature allows customization per user
v Unlimited Record/Playback capability v Pre-defined and user customizable parameter sets
v/ Snapshots (time-stamped and color-coded) and Markers v/ Password protection available per user
v Import recordings from other users v' Acronym and Parameter Libraries
v' Export recordings as text files (ASCII for use in v DTC Library of over 40,000 DTCs

spreadsheets) or EASE Scan Tool recordings v i.SHOP Version 2 Compliant
v/ Add notes to each recording and vehicle v' Keep Your Scan Tool Up to Date with Automatic Web
v Use your own PC * Updates

* MINIMUM PC SYSTEM REQUIREMENTS: Windows XP SP3, Vista or 7, Pentium Il 1 GHz, 512 MB RAM, 1 GB HDD space, DVD-ROM Drive,
one free USB communication port, Wireless Package Only: 2.4 GHz 802.11b/g WiFi wireless capability

The EASE Scan Tool is easy to use. Simply install the software on a PC* and connect the included hardware to the PC and vehicle.

i EASEDIAGNOSTICS © i EASEDIAGNOSTICS °
VEHICLE INTERFACE VEHICLE INTERFACE

5 EVIG00D

Eaxe

Cabled or Wireless Desktop or Laptop
VEHICLE EASE VEHICLE INTERFACE PC

Simply the best tool of its kind in the world ©": !-585-366-ENSE (3273)
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View, Graph & Record Live Data On Your PC

ENTER NEW VEHICLE DATA Vehicle Communications S SCAN TOOL M= B
License Plate State VIN File Vehicle Options View Help
BthVIN#=M Ei
[173.£ASE PA 7] | [25ivSzHewLizizes e gﬁ' [FF]oTe 02 | v S| EH] 2% 2 ! @
T TR Manufacturer: GM Engine: 3.1 VIN=M
n " - 5 VIN: 2G1WL52M6W1121295 Continuous Monitoring Tests OBD Support Level
[Jomes =[sam || [6otenski =] [stephen =l Make: Che\frolet CALID  a%265 G R S| ST
*% Add ‘ £ Delete ‘ =) Rename ‘ * Add ‘ % Delete ‘ 5] Rename | Model: Lumina Owner: Jones, Sam + Misfire Supported Complete Fet Sy ETes
Year: 1998 Technician: Golenski, Stephen f"“‘s"ﬂe'“ Swwported. | Comelete
MAKE MODEL YEAR ENGINE BODY TYPE Component Supported Complete OPENLOOP - has not yet satisfied
= Gth VINGE Ath VINE s conditions to go closed loop.
- FBVINK Monitor Availability Status Fuel System 2 Status
COM Port: COM2 + Catalyst Supported Complete
Cable Status: Connected D Heated Catalyst Unsupported
I 3 @ Evaporative System Unsupported
b Interface Type: VPW @ Secondary Air System Unsupported Secondary Air Status.
[_I—L Tool Status: Receiving Scan @ ALC System Unsupported
= = Data % Oxyyen Sensor Supported Not Complete
dsdtionallinformation, E Oxyuen Sensor Heater Supported Not Complete Power Take Off
Other Criteria it AlC Cruise Turbo ' EGR System Supported Not Complete m
- F F ves Date: 2/14/99
4 5P ALTD ND KO ) ;
Rkl :
Select Previous Vehicle ot veicte Notes... | [/ 0K X cancer | 7 ven | (G=setcoMport.. | Startover.. oK 7 neip_|
Vehicle Selection Screen Vehicle Communications Screen OBD Il I/M Monitors Screen
e Track every vehicle worked on ¢ Vehicle summary ¢ Continuous and Non-Continuous Monitor
e Track License Plate Number and State, ¢ Vehicle to PC communication status Availability and Status
VIN, Owner, Technician and Vehicle Info e Software status e Vehicle OBD Support Level
o Keep notes per vehicle e VIN - GM & Chrysler OBD Il only e Fuel System 1 and 2 Status
e Advanced database filtering e CALID - GM OBD Il only e Secondary Air Status
o Power Take Off Status
BiSE SCAN TOOL [ O] METERS - 1998 Ford Car Ford Escort 2.0L [VIN-P) 1St Previously Recorded S can Files [ [51=]
Eile Vehicle Options User Libiay View Help One |Four |Nine MinMax hwu wiBar | Eight wiBar | Recordings by Vehicle ‘Recordings}ﬂotestevwordﬂ Pnrameters}
& Tk Elorc o mmm| =R B 20 2 MINIMUM CURRENT MAXIMUM Pleass Chooss Vehicle
Snapshot(s) to View Humber T MINIMUM Engine RPM ~| | mAXIMUM Search Order: [Most Recent First ~|  9{iFilter Options... ‘ 1=} Find Recording... ‘
' OnFreeze Frame (" Yellow (F3) * Blue (F5) -
¢ red(F2) ¢ Green Fa) ~ amyorecnange || 21 P0122 2838 Search Text: 4 Clear Filter ‘ @ rindnext |
Snapshot Data for Freeze Frame Last Service [ [Make [Model  [Year ‘Engine‘ﬂ
Time [Deserh [vawe Jures ] iI mm M 12/11/85 12:55:10 PM_ GM Car Chewolet  Carmaro 1098 5.7L
10:54:20 PM_ DTC that caused FF P0O122 WMINIMOR [Short Term Fuel Trim B1 <] | MAXIMUM (1211188 12.54.08 PM_ Ford Car Ford Mustang 1698 46L
10:54:29 PM  Fuel System 2 Status (FF) UNUSED []12/11/88 12.48:11 PM | Chrysler Car Dodge Straus 1898 30L
10:84:29 P _|Puel System 1 Status (FF) o m m {050 1 1oer o o
10:54:29 PM  Calculated Load (FF) 294 % [10/5/88 11:5447 PM_ Honda Car Honda Prelude 1698 29 Jﬂ
10:54:20 PM  Engine Coolant Temp (FF) 219 F % KIN| o
10:54:29 PM  Short Term Fuel Trim B (FF) 078 % MINIMUM 02 Sensor Out Volts B1/S2_~ | | MAXIMUM Choose Recordings from EASE SIM GM Car Chevrolet Camaro 1996
10:54:29 PM  Long Term Fuel Trim B1 {FF) 08 % DateTime Keywords _|Notes lil
10:54:29 PM  Intake MAP (FF) 30 in.hg 0 9 0 - 88 0 - 89 ¥ 10/5/9@ 7:35:26 PM MAP Intermittent MAP Sensor Detected
10:54:30PM  Engine RPM (FF) 1003 o [ [10/5/86 7.3526 PM  PO107 | MAP Circuit Low Input Error
=l v 10586 79526 PM EvAP Loose Gas Cap -
Setup.. S ox Fnen | . ;IJ
EIE] EREIE] I Roool | swtune | torseoanion || Sox | 70k | ®mpore. | Byewort. | Foseo. |[ ok | Koo | 7w |

OBD Il Freeze Frame Data Meters Record/Playback Capability

e Saves data if DTCs are cleared o View parameters in a larger format ¢ Record unlimited data

e View Snapshot data e View up to 9 meters at once ¢ Recorded file database
e View Failure Records (GM OBD lI) e Track the minimum/maximum values of e Notes per recording
* Snapshot when DTC occurs a parameter with Min/Max Meters ¢ Import files from other users

Tri-color bar graphs e Export files to ASCII (text)
Customize colors
FiS SCAN TOOL ED (= E3 CEZTEIIER
g? DDTC 02 /M KN | EE % % ' @ Search Text: [Po10s Search Order: [eyo1c - FT ,, T
DTC Type Current DTC Count Next Code: pTC \Descrirﬂinn _ |ﬂ : :: —— j
_ L R e PN e 7
i fto-t ) | P0103  Mass or Velume Circuit High Input SR L 2
DTC DTC Activation Time |_|[PO104  Mass or Yolume Circuit Intermittent L]
P0105  Manifold Absolute Pressure/Barometric Pressure Circuit Malfunction
P 0 1 0 7 : P0106  Manifold Absolute Pressure/Barometric Pressure Circuit Range/Performance Problem
P0107  Manifold Absolute Pressure/Barometric Pressure Circuit Low Input
e —— [ P05 _|anitod Absoluts PrssuriBarometic Pressure Creuit igh nput________ |
a User Joe Smith Notes on DTC P0108 for Generic
Manifold Absolute B 2
Pressure/Barometric Pressure T This is where you can type notes on
5 % aDTC.
Circuit Low Input d
Lo T -1 ... e e e T
DTCs Information Libraries Snapshots

e Continuous DTC Scan and DTC Alert e Diagnostic Trouble Codes (DTC) Library e Custom snapshot configurations
e DTCs are time-stamped as they occur e Customizable DTC Library e Time-stamped and color-coded
e Clear DTCs (if supported by vehicle) e Automotive Acronym Library e Automatic DTC snapshot
e Generic and Enhanced DTC Scan e Parameter Library ¢ Unlimited number of snapshots

More Display Area Means More Information °C°': 1-888-366°EASE (3273)

Web: www.ohd2.com
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All Scan Tools are NOT Created Equal
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Charts (Graphing) Charts (Graphing) Charts (Graphing)
e Auto scale, zoom features e Graph in time (seconds) or frames e View up to 6 charts
o Best detailed graphing available e Graph multiple parameters e Markers and snapshots visible
¢ Note the 60 RPM swing and +/- 2% o Values tracked digitally o Easily change parameters and setup
Short Term Fuel Trim. Try displaying e 8 seconds of GM OBD Il High Speed o Overlay graph traces to compare
detail like this on other scan tools! Powertrain shown. Amazing detail! o View effect of bi-directional controls
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Real Time Data Grid Real Time Data Grid Real Time Data Grid

e View 1 to 80+ data parameters ¢ Single or Double Column Mode e English or Metric

e Customize Sampling Rates e Reorder parameters e Create your own parameter groups

e GM OBD Il Powertrain shown e Ford OBD Il GEM shown e Column sorting

e GM Cars - typically 130+ PT parameters e Ford - typically 200+ powertrain e Chrysler OBD Il Powertrain shown

e GM Trucks - typically 200+ powertrain parameters per vehicle e Chrysler - typically 200+ powertrain
(PT) parameters parameters per vehicle
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GM Bi-Directional Controls Ford Bi-Directional Controls Chrysler Bi-Directional Controls
o Activate outputs to assist in diagnosis o Activate outputs to assist in diagnosis o Activate outputs to assist in diagnosis
¢ View data while using bi-directional ¢ View data while using bi-directional ¢ View data while using bi-directional
controls controls controls
e GM OBD Il Powertrain shown e Ford OBD Il GEM shown e Chrysler OBD |l Powertrain shown

Technicians Wonder How They Worked Without It 62" 1-888-365°EASE (3273)

Weh: www.ohd2.com ..,




Get Started With Domestic & Asian Package

H

EASE-10-C

-

Includes:
Cabled Venhicle Interface

1 Year of Technical Support

Domestic Enhanced
Chrysler

» Includes Support for Chrysler, Dodge,
Eagle, Jeep and Plymouth Vehicles

» 1992 - 2010 Model Years Supported *
» 2002 - 2010 Dodge Sprinter Support
» Cummins Diesel Support

» Read Powertrain, Body & Chassis
Enhanced Data & DTCs and Perform

Powertrain, Body & Chassis Bi-
directional Controls
Ford

» Includes Support for Ford, Lincoln and
Mercury Vehicles

» 1984 - 2010 Model Years Supported *

» Ford 7.3L Power-Stroke, 6.0L & 6.4L
Diesels Support

» Read Powertrain, Body & Chassis
Enhanced Data & DTCs and Perform
Powertrain, Body & Chassis Bi-
directional Controls

General Motors

» Includes Support for Buick, Cadillac,
Chevrolet, GMC, Hummer, Pontiac and
Saturn Vehicles

» 1982 -2010 Model Years Supported *

»Duramax Diesel and Allison
Transmission Support

» Read Powertrain, Body & Chassis
Enhanced Data & DTCs and Perform
Powertrain, Body & Chassis Bi-
directional Controls

* Domestic Pre-OBD Il vehicles require the
purchase of additional cables

\_

USB Cable & Power Transformer

m Domestic & Asian PC Scan Tool Software - Version 10
m OBD Il Generic PC Scan Tool Software - Version 10

m OBD Il Generic & Enhanced Vehicle Cables
|
|
.

Wireless Package Available - Part #: EASE-10-W

Data Highlights - see www.obd2.com for more information

Domestic & Asian PC Scan Tool Package - Cabled \

Asian Enhanced

Acura

» Read Powertrain, Body & Chassis
Enhanced Data& DTCson 1996 - 2010
plus 1994-95 OBD Il Acura Vehicles

Honda

» Read Powertrain, Body & Chassis
Enhanced Data & DTCs on 1996 - 2010
plus 1994-95 OBD Il Honda Vehicles

Hyundai

» Read Powertrain Enhanced Data &
DTCson 2005 - 2007 Hyundai Vehicles

Infiniti

» Read Powertrain, ABS, Air Bag & Body
Enhanced Data & DTCs (CAN & DDL2
only) on 2000 - 2009 Infiniti Vehicles

Isuzu

» Read Powertrain, Body & Chassis
Enhanced Data & DTCs and Perform
Powertrain Bi-directional Controls on
1996 - 2008 Isuzu Vehicles

Kia

» Read Powertrain Enhanced Data &
DTCson 2004 - 2008 Kia Vehicles

Lexus

» Read Powertrain, Body & Chassis
Enhanced Data & DTCs and Perform
Powertrain, Body & Chassis Bi-
directional Controls on 1996 - 2010
Lexus Vehicles

Mazda

» Read Powertrain, Body & Chassis
Enhanced Data & DTCs and Perform
Powertrain, Body & Chassis Bi-
directional Controls on 1996 - 2010
Mazda Vehicles

Mitsubishi

» Read OBD Il Generic Data for 1996 -
2010 Mitsubishi Vehicles

Nissan

» Read Powertrain, ABS, Air Bag & Body
Enhanced Data & DTCs (CAN & DDL2
only) on 2000 - 2009 Nissan Vehicles

Scion

» Read Powertrain, Body & Chassis
Enhanced Data & DTCs, Perform
Powertrain, Body & Chassis Bi-
directional Controls on 2004 - 2010
Scion Vehicles

Subaru & Suzuki

» Read OBD Il Generic Data for 1996 -
2010 Subaru & Suzuki Vehicles

Toyota

» Read Powertrain, Body & Chassis
Enhanced Data & DTCs and Perform
Powertrain, Body & Chassis Bi-
directional Controls on 1996 - 2010
Toyota Vehicles

OBD Il Generic
» Read OBD Il Generic Data & DTCs for 1996+ Domestic, Asian & European vehicles.
» Supports SAE J1850(VPW, PWM), ISO 9141-2(1SO), ISO 14230(KWP2000) & ISO

15765/SAE J2284 (CAN) Protocols

DTCs (Mode $0A/10) and much more

» Full expanded Generic PID Support, Mode 6 & Mode 9 Support, Read Permary

Start Scanning with EASE Today!!

Call: 1-888-366-EASE (3273)
Web: www.obd2.com

EASE




Get Started With Domestic Package
¥

/DOM-PTBC-lO-C Domestic Package - Cabled \

Includes:

Cabled Vehicle Interface

m Domestic PC Scan Tool Software - Version 10

m OBD Il Generic PC Scan Tool Software - Version 10
m OBD Il Generic & Enhanced Vehicle Cables
]
|
.

USB Cable & Power Transformer
1 Year of Technical Support
Wireless Package Available - Part # DOM-PTBC-10-W

Data Features: *

CHRYSLER
K Tt 2
General Motors Ford

Chrysler
» Includes Support for Buick, Cadillac,  » Includes Support for Ford, Lincoln » Includes Support for Chrysler, Dodge,
Chevrolet, GMC, Hummer, Pontiac and Mercury Vehicles Eagle, Jeep and Plymouth Vehicles
and Saturn Vehicles » 1984 - 2010 Model Years Supported * » 1992 - 2010 Model Years Supported *
> 1982 - 2010 Model Years Supported *  » Ford 7.3L Power-Stroke, 6.0L & 6.4L  » 2002 - 2010 Dodge Sprinter Support
» Duramax Diesel and Allison Diesels Support » Cummins Diesel Support
Transmission Support » Hybrids Support > Hybrids Support
> Hybrlds Support » Read Powertrain, BOdy & Chassis » Read Powertrain, Body & Chassis
» Read Powertrain, Body & Chassis Enhanced Data Enhanced Data
Enhanced Data > Perform Powertrain, Body & Chassis  » perform Powertrain, Body & Chassis
» Perform Powertrain, Body & Chassis Bi-directional Controls Bi-directional Controls
Bi-directional Controls > Read & Clear Powertrain, Body & » Read & Clear Powertrain, Body &
» Read & Clear Powertrain, Body & Chassis Enhanced DTCs Chassis Enhanced DTCs
Chassis Enhanced DTCs » Supports PWM, SCP, ISO, CAN, > Supports SCI A& B, CCD,
» Supports GM LAN, Single Wire CAN, MCAN, ISO 14229, DCL Protocols NGC/J2190, CAN Protocols
VPW, J2190, UART, ALDL 160, 8192, » Diagnostic Tests, KOEO and KOER,  » CAN with Gateways, Version and
9600 Baud Protocols Self Tests for Gasoline and Diesel Variant
> VIN Decode, Controller List > ABS Brake Bleed » Exercise Actuators & Engine Controls
> WARP Data Speed Rate, 40 times > Part # Decode, Controller List » Perform Memory Resets, Actuator
per _second » Reference Library - 1000 pages and AIS Commands
> Static Data, VIN, CALID, Part #s » Ford's DTC Reference » Performs Special Tests

> Reference Library Over 8000 Pages  nNote: Does Not Support Ford UBP

* Domestic Pre-OBD Il vehicles require the purchase of additional cables

OBD Il Generic
» Read OBD Il Generic Data & DTCs for 1996+ Domestic, Asian & European vehicles.
» Supports SAE J1850(VPW, PWM), ISO 9141-2(1SO), ISO 14230(KWP2000) & ISO 15765/SAE J2284 (CAN) Protocols
» Full expanded Generic PID Support- 141 PIDS. Plus EASE custom PIDS like Rich/Lean Status & Engine Vacuum
» Read and Clear Stored &Pending, Generic & Manufacturer-Specific DTCs & Descriptions and Freeze Frame Data
» Enhanced DTC Scan & Description Library, Read Permanent DTCs (Mode $0A/ 10)
» Mode 6 Support - View Raw and Translated Results Per OEM in Grid and Report Format
» Mode 9 Support - Vehicle Information - VIN, CALID, CVN and In-Use Performance Counters
\>View 02 Sensor Test Results, I/M Monitors Availability and Status, OBD Support Level, OBD Il Generic only can /

Fuel System 1 & 2 Status, Secondary Air Status, and PTO Status also be purchased separately

Start Scanning with EASE Today!! = “er: menatts com
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Other EASE Products

EASE DIAGNOSTICS
VEHICLE INTERFACE

EVI-6000

Go Wireless
with EASE!!

={TEM: DOM-PTBC-10-W or EASE-10-W Scan Tool Package with Wireless Capability
(Includes everything you get with Cabled (-C) Scan Tool Package except you get the EASE
Wireless Vehicle Interface in place of the Cabled Vehicle Interface)

Imagine the productivity and cost savings you can realize by using the latest in wireless

diagnostics technology. Diagnose problems from across the bay or even outside your shop. Work
comfortably inside - leave bad weather outside on hot, cold, snowy or rainy days!! The efficiency
of WIRELESS TECHNOLOGY combined with the EASE PC SCAN TOOL means faster repairs!

Data Logging

w5 [TEM: MINI-DL

How many times has a customer
complained about an intermittent
problem and your test drive can’t
duplicate it? Using the EASE Mini
Data Logger (MDL), the customer records data while driving and
brings it back to you for diagnosis and repair. The MDL captures
OBBD Il generic data on 1996 + vehicles. With the MDL, you can
analyze the data recorded BEFORE, AFTER and DURING the
problem to repair the problem correctly. Fixing the car right the
firsttime means happy customers and extra profits for you.

Read &
Clear DTCs

u= [TEM: QC2-HH-CAN

A must have in every technician’s
toolbox, the EASE QuikCode™ is a
professional, stand alone, hand-held code scanner that quickly
and accurately retrieves and clears stored and pending generic
and manufacturer-specific Diagnostic Trouble Codes (DTC) for
OBD Il compliant Domestic, Asian, and European vehicles. It
also retrieves and clears the current MIL status and I/M
Readiness Monitor status. VIN retrieval is supported on 2002
and newer vehicles that support Mode 9 VIN data. Amanual that
lists thousands of OBD || DTCs is included.

o, PC Scope

. e u> [TEM: PC-SCOPE-42U-KIT
_ Turn your PC into a powerful,

= r' &m high resolution oscilloscope with
i::‘_—]__r the EASE PC Scope. Combine
o ' this with the EASE PC Scan Tool
to create the ultimate diagnostic workstation. This exclusive
EASE software was designed with the automotive technicianiin
mind. Our unique, automotive specific features make it the
most powerful and useful Automotive Scope around. It even
contains an extensive Waveform Library allowing comparisons
between known “good” waveforms and your live data.
Automotive Diagnostics made EASY - from EASE Diagnostics.

Reflash
Vehicles

EASE DIAGNOSTICS .

Universal Reprogrammer II .

= w5 [TEM: J2534-URI-KIT

As OEMs add even more
computers to their cars, the need
for FLASH REPROGRAMMING to diagnose and repair
modern automobiles gets more critical every day. Shifting,
hesitation, rough idle, emissions quality, performance, and
other problems must be corrected by reprogramming the car’s
computers with the latest OEM calibration files. Withthe EASE
Universal Reprogrammer |1, you can reflash virtually all OBD |l
Domestic, Asian and European vehicles on the road today.
Don’t miss out on this exploding and profitable market.

Copyright 1999-2010, EASE Diagnostics. All rights reserved. Information in this document is subject to change without notice.
All trademarks are property of their respective owners. The display of trademarks in this document does not imply that any license has been granted by its owner.
No trademark infringement is intended and no suggestion is made that the owner of the trademark endorses our products.

Create the Ultimate Diagnostic Workstation

Call: 1-888-366-EASE (3273)

Web: www.ohd2.com
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